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BiblioteQ

Introduction

BiblioteQ is a complex, highly-configurable, and mature library suite. The software supports large,

medium, and small institutions.

BiblioteQ should be functional on any operating system where Qt LTS, SQLite, and YAZ are
supported. BiblioteQ also supports the PostgreSQL database engine. Qt 4.8.x is considered obsolete

and is not supported. The YAZ library is optional.

The source of BiblioteQ is available at https://github.com/textbrowser/biblioteq.

The purpose of this document is to detail the functionality of BiblioteQ. Installation instructions are not
described in this document. Please refer to the Administrator Guide document for installation

&= BiblioteQ: BiblioteQ.sqlite (administrator) A
File Edit View Tools Options Help
EQEENE "HEx2 DRAYE B8
search | Accession Number | se Case Insensitive Reset
LR Title & Authors Publisher Publication Date Place of Publication Edition
Asample Book  Author Publisher 01/01/2000 N/A 1
=
ASample Book  Author Publisher 01/01/2000 N/A 1
After After Man
M3 (Expanded 40th .
Dougal Dixon Breakdown Press Limited | 01/01/2021 N/A 1
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2 Edition)
An introduction  Hoffstein, Jeffrey. Pipher, Jil
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L | Ballpark eats
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b3l atom's odyssey
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ic=ry "
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Accessing an Existing SQLite Database

An existing SQLite database file may be opened via two methods. The first method involves the Recent
SQLite Files option of the File menu.

1 Mew SQLite Database... ctri+N
Recent SQLite Files b

(# Connect... Ctri+C

(MY Disconnect Ctri+D

[Z Export Icons View as PNG...

[ Export Table View as CSV...
& Print Icons View...

E3 Exit BiblioteQ Ctri+Q

The Recent SQLite Files sub-menu contains a list of BiblioteQ’s recently-accessed SQLite files. If an
SQLite file is selected, the specified SQLite database is opened. Please note that BiblioteQ will first
close an existing database, if one is open, before opening the specified database. A Clear option is also
included in the sub-menu. If Clear is activated, the list of the recently-accessed SQLite files is emptied.
BiblioteQ will remove duplicate sqlite_db_ entries from the INI file shortly after the application is
launched. Also removed will be entries whose corresponding files lack read and write permissions.

The second method of accessing an SQLite database is through the Branch Selection dialog. The dialog
may be accessed via the Connect option of the File menu.

BiblioteQ: Branch Selection

Branch Mame | local_db o

E Select SQLite Database...

~ Connect = Reset ® cancel
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After opening the Branch Selection dialog, select local_db as the Branch Name. This will prepare the
dialog for accessing SQLite databases. Afterwards, click on the Select SQLite Database button to
launch a file-selection dialog.
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Adding An Item

For PostgreSQL databases, items may be added by administrator and librarian accounts. For SQLite
databases, file owners may add items.

BiblioteQ supports books, compact discs, digital video discs, grey literature, journals, magazines,
photograph collections, and video games.

To add an item, click on the Add Item tool button and select the desired category. A Create window will
be displayed. Required fields are highlighted.

Multiple items may be added simultaneously.

6 of 50



BiblioteQ

Administrator Browser

The Administrator Browser is available if an administrator role is connected to a PostgreSQL database.
The browser may be accessed via the Configure Administrator Privileges tool button.

Four roles are available. Changes should be committed via the Save Changes button.
The process of committing changes to the PostgreSQL database is as follows:

1. The table’s current state is inspected. The operator is notified of administrators without
privileges as well as duplicate administrators and the process is aborted.

2. A database transaction is prepared. If an error occurs, the process is aborted.

3. Deleted accounts are removed from the admin database table as well as from the PostgreSQL
database. If an error occurs with either sub-process, the process is aborted and the previous
changes are reverted.

4. Existing admin table entries are updated. New accounts are inserted into the admin table. If an
error occurs, the process is aborted and the previous changes are reverted.

5. Existing admin table entries are granted the specified privileges after all potential privileges are
revoked. New accounts are created in the PostgreSQL database and assigned the appropriate
privileges. If an error occurs, the process is aborted and the previous changes are reverted.

6. If all of the aforementioned statements execute correctly, the database transaction is committed.

Please note that leading and trailing spaces will be removed from user names during the database-
recording process.

tion Item Deletion Item Reservations Item R s Item Updates Member Creation Member De
v v v v v v -
v v
i = a
Ad Gircul Librarian W
5 -
m] 0 O m)
] a L] (]
O o O O]
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BiblioteQ.INI

The BiblioteQ.INI file contains interface settings. The file resides in the user’s home directory within
the .biblioteq folder. Editing should be performed with care.
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BiblioteQ.conf

The BiblioteQ.conf file contains Amazon, SRU, Z39.50, and other information. Please edit this file
using a text editor.
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Change Password

A PostgreSQL account’s password may be changed via the Password Selection dialog. A password
must contain at least eight characters. Guest accounts are excluded.

®

Userid xbook_admin
‘J New Password PostgreSQL Password

Confirm Password | PostgreSQL Password Confirmation

+ Save ® Cancel
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Connecting to a PostgreSQL Database

BiblioteQ supports both the PostgreSQL and the SQLite database engines. This section will cover the
details involved in connecting to a PostgreSQL database.

1 Mew SQLite Database... ctri+N
Recent SQLite Files b

(B Connect... Ctri+C

(MY Disconnect Ctri+D

[Z Export Icons View as PNG...
[ Export Table View as CSV...

& Print Icons View...

E3 Exit BiblioteQ Ctri+Q

Click the Connect option of the File menu.

=

Branch Name | xbook_db ~r

Userid Guest e

Password [] show

~ Connect =~ Reset ® cancel

Select the appropriate non-local_db Branch Name if one is available. Provide the Password and Userid
information, if applicable, and press the Connect button.

Note: The sections Accessing an Existing SQLite Database and Creating an SQLite Database cover the
details of accessing and creating SQLite databases, respectively.
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Creating a PostgreSQL Database

BiblioteQ supports PostgreSQL 8.x, 9.x, and newer. Please note that PostgreSQL 8.x and 9.x are not
supported by PostgreSQL. Please follow the PostgreSQL-provided documentation for installing
PostgreSQL. After installing the required PostgreSQL packages, please perform the following
operations:

1. Create the xbook_db database via createdb xbook_db -E UTF8 or via the PostgreSQL-
recommended procedure. Please note that the database name xbook_db is only a suggestion.

2. Execute createlang plpgsql -d xbook_db or the PostgreSQL-recommended procedure for adding
a new programming language to the xbook_db database. If the language already exists,
PostgreSQL will produce an error. Please ignore the error.

3. If desired, replace all instances of the default administrator xbook_admin in the
postgresql_create_schema.sql file. A password may also be set afterwards.

4. Log into your PostgreSQL xbook_db database and load the postgresql_create_schema.sql file
via \i postgresql_create_schema.sql.
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Creating an SQLite Database

A new BiblioteQ SQLite database file may be created via the New SQLite Database option of the File
menu.

1 Mew SQLite Database... ctri+N
Recent SQLite Files b

(B Connect... Ctri+C

(B Disconnect Ctri+D

[Z Export Icons View as PNG...
[ Export Table View as CSV...

& Print Icons View...

E3 Exit BiblioteQ Ctri+Q

After the option is selected, a file-selection dialog is displayed. An existing or a new file may be
specified. A confirmation dialog is displayed if an existing file is selected.

Once the SQLite database file has been initialized, BiblioteQ will open it. If a database is already open,
a confirmation prompt is displayed. If confirmed, the current database is closed and the newly-created
database is opened.
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Custom Query

Custom SQL queries may be performed via the Custom Query window.

After a successful query is performed, the main table’s columns will be set according to the query
statement. Please avoid including columns of type QByteArray in the custom query as the associated
data will burden the software.
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Database Content

All content, save for configuration values, is stored in the respective database. For instance, image data
are stored in a database. Temporary data reside in the application’s memory space.

Image information is recorded as Base-64.
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Database Enumerations Browser

The Database Enumerations Browser is available to accounts having administrator or librarian
privileges and is accessible via the Database Enumerations tool button. The browser contains
configurable item values. The browser is available for PostgreSQL and SQL.ite databases.

The process of committing changes to a database is as follows:

1. For each sub-panel (Book Binding Types, etc.), a database transaction is prepared. If an error
occurs, the process iterates to the next sub-panel.

2. All items in the respective database table are deleted. For example, for the Book Binding Types
sub-panel, all entries from the book_binding_types database table are deleted. If the process
fails, changes are reverted and the process proceeds to the next sub-panel.

3. New values are inserted into the respective database table. If the process fails, changes are
reverted and the process proceeds to the next sub-panel.

4. The current database transaction is committed.
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Disconnecting from a Database

To disconnect from a connected database, click the File menu. Then click the Disconnect option.

51 Mew SQLite Database... Ctrl+M
Recent SQLite Files >

(#| Connect... Ctri+C

|®y Disconnect Ctri+D

[Z Exportlcons View as PNG...
[Z Export Table View as C5V...

& Print Icons View...

E3 Exit BiblioteQ Ctrl+Q
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Error Log

The Error Log may be accessed via the View menu. The window details critical exceptions which were
raised during a BiblioteQ session. The status bar of the main window will indicate whether or not the

log contains entries.

Event Time Event Type Full Description

~ To Clipboard | | =~ Reset
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Exporting a Table View to a CSV File

The current table view’s contents may be exported to a CSV file via the Export Table View as CSV
option of the File menu.

1 Mew SQLite Database... ctri+N
Recent SQLite Files b

(B Connect... Ctri+C

(B Disconnect Ctri+D

[Z Export Icons View as PNG...
[ Export Table View as CSV...

& Print Icons View...

E3 Exit BiblioteQ Ctri+Q

If clicked, a file-selection dialog is displayed.

The generated CSV file will contain comma-separated values. Values which contain commas will be
encased in double-quotes. For example, A book of abstract algebra,"Pinter, Charles C.",McGraw-
Hill, 1990-01-01,New York,2,"Algebra,
Abstract.",English,0070501386,0.00,Dollar,1,Hardcover,Home,9780070501386,89035355,QA162 .P56
1990,512/.02,1,0,0riginal,As New,.

The first line of the generated file contains the exported view’s header strings. The exported columns
are governed by the settings in Viewable Columns.

19 of 50



BiblioteQ

File Attachments

Several categories (books, grey literature, journals, magazines) include file attachments. Attached files
are compressed before being inserted into the respective database. BiblioteQ employs the ZLIB
algorithm for compression.
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Hyperlinks

BiblioteQ supports embedded hyperlinks. If a hyperlink is clicked, a search is initiated using the
specified text for the given category. Please note that a clicked hyperlink will not be activated if the
parent widget is editable. An example hyperlink: <a href='"book_search?category?Number
Theory>Number Theory</a>.

Place of Publication
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Importing
BiblioteQ provides an import mechanism for importing book and patron data contained in a CSV file.
Please review the Tools menu.
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Limitations

BiblioteQ does not impose limits on the data content. Please note that both PostgreSQL and SQLite
have rigid limits. Please read https://www.sqlite.org/limits.html for SQLite details.

Generally:

* Attached files may be of any size. Please note that submitting large files will burden both local
and remote queries. PostgreSQL and/or SQLite may limit field sizes.

* Infinitely-many items may be stored, although PostgreSQL and/or SQLite may prevent this.
* Pagination is implemented with the use of the LIMIT and OFFSET clauses.

* The number of PostgreSQL accounts is not limited through the software.
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Main Window Tool Buttons

This page will describe the various tool buttons which are present on the main window.
The tool buttons are described from left to right.
View Selected Item(s)

Open the detail window(s) of the selected item(s). A confirmation prompt is displayed if the number of
selected items exceeds four. The tool button is disabled if the current account has administrator
privileges.

Add Item
Add an item. The tool button is disabled if the current account does not have Item Creation privileges.
Duplicate Selected Item(s)

Open the detail window(s) of the selected item(s). A confirmation prompt is displayed if the number of
selected items exceeds four. The tool button is disabled if the current account does not have Item
Creation privileges.

Delete Selected Item(s)

Delete the selected item(s). A confirmation prompt is displayed. The tool button is disabled if the
current account does not have Item Deletion privileges.

Modify Selected Item(s)

Modify the selected item(s). A confirmation prompt is displayed if the number of selected items
exceeds four. The tool button is disabled if the current account does not have Item Updates privileges.

Print Current View
Print the items in the current view. A Print dialog is displayed.
Select Viewable Columns

Select the columns that are to be shown in the main window’s table per each category (books, cds, etc.).
Please note that column order is not preserved.

View Member’s Reservation History (Patrons Only)
Display the current patron’s reserved items. The tool button is enabled only for patron accounts.

Request Selected Item(s) / Cancel Selected Request(s)
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Available for patrons, these options allow for the requesting of items as well as for the canceling of
requested items.

Reserve Selected Item

Reserve the selected item. The tool button is disabled if the current account does not have Item
Reservations privileges.

Display Members Browser

Display the Members Browser window. Only available for administrator, circulation, and membership
accounts.

Files Browser

Display the Files Browser window.

Database Search

Activates a context menu containing various search options.
Custom Database Query

Display the Custom Query window.

Refresh Table

Reload the current view.

Again, the tool buttons are described from left to right.
Connect

Display the Branch Selection dialog.

Disconnect

Disconnect from the current database.

Change Password

Display the Password Selection dialog. Not available for PostgreSQL guest accounts and SQLite
databases.

Configure Administrator Privileges

Display the Administrator Browser window. Only available for administrator accounts. Not available
for SQLite databases.

Database Enumerations
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Display the Database Enumerations Browser window. Only available for administrator and librarian
accounts.

Exit BiblioteQ

Terminate the application.
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Members Browser

The Members Browser is available from the View menu. For PostgreSQL databases, the browser is
accessible if the current role is administrator, circulation, or membership. For SQLite databases, access
to the browser is always granted.

The browser allows administrators to create, delete, and modify patron account details. Reservation
processes are also available in the Members Browser. A mechanism for exporting the patrons is also
included.

Grant Privileges

Grant Privileges is available for PostgreSQL databases. If pressed, each listed account is removed from
and added to the biblioteq_patron role.

Direct PostgreSQL Documentation

PostgreSQL manages database access permissions using the concept of roles. A role can be thought of
as either a database user, or a group of database users, depending on how the role is set up. Roles can
own database objects (for example, tables and functions) and can assign privileges on those objects to
other roles to control who has access to which objects. Furthermore, it is possible to

grant membership in a role to another role, thus allowing the member role to use privileges assigned to
another role.

The concept of roles subsumes the concepts of “users” and “groups”. In PostgreSQL versions before
8.1, users and groups were distinct kinds of entities, but now there are only roles. Any role can act as a
user, a group, or both.
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Member’s Reservation History

A patron’s reservation history may be accessed via the Member’s Reservation History window.
Reservation histories are initially disabled.
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Open Library

BiblioteQ supports the Open Library Internet search query for books.
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Operating Systems

BiblioteQ supports Android, FreeBSD, Linux, Mac OS X, OS/2, OpenBSD, and Windows. Generally,
the application should be compatible with any operating system where Qt, SQLite, and YAZ are
supported. Please note that the YAZ library is totally optional. The software has also been tested on a
variety of architectures, including AMD, ARM, Alpha 21264, PowerPC, and Sun UltraSparc.
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PDF

BiblioteQ supports PDF content through the Poppler open source library. Browsing, printing, and
searching options are included. Support is optional.

BiblioteQ: PDF Reader (NautilusDi_68-71.pdf)

File Edit View

~

Page |1 View | 100% v

Search Find Mext | Find Previous | | Case Sensitive

Page 1
Page 2
Page 3
Page 4
Page5
Page 6

Page 7

GENES ARE DVTRIR.AI'ED IY:OILIR BRAIN Dr‘l MAGIC ‘ ﬂ. MIDLIFE AFFMRIWITH GEOMETRY
Page 8

Page 9

Page 10
Page 11
Page 12
Page 13
Page 14
Page 15
Page 16
Page 17
Page 18
Page 19
Page 20
Page 21
Page 22
Page 23
Page 24
Page 25
Page 26
Page 27
Page 28
Page 29
Page 30

Page 31
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PostgreSQL Accounts

BiblioteQ provides three tiers of PostgreSQL database roles: administrator, guest, and patron.

Initially, the postgresql_create_schema.sql script may be used to create the administrator account
xbook admin.

Guest roles are provided a read-only interface. Patron roles are granted reservation permissions.

PostgreSQL accounts may be modified via the Administrator Browser. Please note that the
Administrator Browser is only available within an administrator role.

Please use lower-case IDs.

Itern Creation Itern Deletion Item Reservations Item Returns Item Updates Member Creation Member De
P ~—

»
i
3
3
]
8
{
{
{
{
{

1Y Administrator | Circulation Librarian n

i
i
00

Additionally, there are four administrator levels: Administrator, Circulation, Librarian, and
Membership. The abilities of each level is described next.

Administrator permissions:
* Item Creation
Ability to create books, etc.
* Item Deletion
Ability to remove books, etc.
* Item Reservations
Ability to reserve items.
* Item Returns

Ability to process returned items.
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* Item Updates
Ability to modify books, etc.
*  Member Creation
Ability to create administrators and patrons.
*  Member Deletion
Ability to remove administrators and patrons.
*  Member Updates
Ability to update information of patrons and permissions of administrators.
* Reservation Histories
Ability to read reservation histories of patrons.
Circulation permissions:
* Item Reservations
* Item Returns
* Reservation Histories
Librarian permissions:
* Item Creation
* Item Deletion
e Item Updates
Membership permissions:
*  Member Creation
*  Member Deletion

*  Member Updates
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PostgreSQL Benefits

PostgreSQL is an open-source relational database management system. Some of the benefits of
PostgreSQL include:

* High standards compliance.
* Indices.

* Networking.

* Notifications.

* Procedural languages.
* Replication.

* Rich data types.

* Roles.

* Schema support.

* Transactions.

» Triggers.

* User-defined types.
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PostgreSQL unaccent()

BiblioteQ supports PostgreSQL's unaccent() extension. Documentation describing the unaccent()
function is located at https://www.postgresql.org/docs/current/unaccent.html.

Greek-language users may wish to supplement their unaccent.rules files with information contained at
https://gist.github.com/marinoszak/7d5d6a8670faae0f4589c2da988f2ba3. The PostgreSQL database
may require restarting after a rules file is altered.
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Preparing biblioteq.conf

The biblioteq.conf file contains non-user settings. The location of the file varies with distribution. This
page will describe the various properties which may be defined in the biblioteq.conf file.

[Amazon Back Cover Images]

Describes required settings for retrieving book back-cover images from amazon.com.
host

Host name of the Amazon image server.

path

Path of the image file. BiblioteQ substitutes the respective ISBN in the percent sign. Please note that
ASINs may also work.

The optional properties proxy_host, proxy_password, proxy_port, proxy_type, and proxy_username are
also supported. The proxy_type property supports values of HTTP, None, Socks5, and System.

[Amazon Front Cover Images]

Please read previous section.

[Branch-1]

The first database branch.

connection_options

PostgreSQL-specific connection options. An example is connect_timeout=10;ssImode=verify-full.
database_name

The name of the database as it will appear in the Branch Selection dialog.
database_type

The database’s type. Must be set to postgresql or sqlite.

hostname

The host name of the PostgreSQL database server. Both IP addresses and fully-qualified domain names
may be assigned.

port

The port value of the PostgreSQL database server.
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ssl_enabled

If false, SSL/TLS communications are disabled.

[Open Library]

Describes required settings for retrieving book information from openlibrary.org

url_isbn

URL of book. BiblioteQ substitutes the respective ISBNs.

[Open Library Cover Images]

Describes required settings for retrieving book cover images from covers.openlibrary.org.
back_url

URL of the back-cover image file. BiblioteQ substitutes the respective ISBN in the $value field.
front_url

URL of the front-cover image file. BiblioteQ substitutes the respective ISBN in the $value field.
[SRU-1]

Describes the first SRU site.

name

Name of the site as it will appear in the application.

url_isbn

Complete URL of the site for retrieving data via ISBNs. The tokens %1 and %?2 are replaced by the
ISBN-10 and ISBN-13 fields.

url_issn
Complete URL of the site for retrieving data via ISSNs. The token %1 is replaced by the ISSN field.

The optional properties proxy_host, proxy_password, proxy_port, proxy_type, and proxy_username are
also supported. The proxy_type property supports values of HTTP, None, Socks5, and System.

[Z239.50-1]

Describes the first Z39.50 site. Please also see http://www.indexdata.com/vaz/doc/zoom.records.html.

database_name

The remote database name.
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format

Render format. An example: marc8,utf-8.

name

Name of the site as it will appear in the application.
password

Account password. Optional.

port

The remote database’s port number.

record_syntax

Preferred record syntax. Example: MARCZ21.

The optional properties password, proxy_host, proxy_port, and username are also supported.
timeout

Maximum number of seconds for the query to complete.
username

Account username. Optional.

yaz_

Configure YAZ options. The option (yaz_option minus yaz_) must be supported by the YAZ library.
For example, yaz_charset and yaz_databaseName are suitable options.
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Requesting an Item

PostgreSQL patrons may request one or more books, compact discs, digital video discs, grey literature,
journals, magazines, and video games. After selecting an item, please press the green Telephone tool
button. To cancel a request, please set the Category to All Requested, select the desired item, and press
the red Telephone tool button. A confirmation dialog is displayed and if accepted, the selected request

is canceled.
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Reserving an Item

For PostgreSQL databases, items may be reserved by administrator and circulation accounts. Owners
of SQLite databases may reserve items. Books, compact discs, digital video discs, grey literature,
journals, magazines, and video games may be reserved. To reserve an item, select it in the main
window and press the Reserve Selected Item tool button. If the item is available for reservation, the
Members Browser will be displayed. Select the desired patron in the Members Browser and press the
Reserve Selected Item tool button in the Members Browser. The Copy Browser dialog is displayed.
Specify the Due Date and select the desired copy. Finalize the reservation process by clicking the
Reserve button.

Please note that the default Due Date may be modified via the Database Enumerations Browser.
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Returning an Item

For PostgreSQL databases, reserved items may be returned by administrator and circulation accounts.
Owners of SQLite databases may return reserved items. The simplest method of identifying reserved
items is by the All Reserved category of the View menu. An item may be returned via its details
window. Open the selected item’s details and click the Reservation Status button. The Item Reservation
Status dialog is displayed. Select the copy which is about to be returned and click the Return button.
Confirm the process.

Selected items may also be returned via the All Reserved category.

41 of 50



BiblioteQ

SQL Injections

Most BiblioteQQ queries are parameterized. Prepared SQL statements are resilient against SQL
injections. Please note that some fixed fields (for instance, Locations) are embedded in the statements.
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SRU & Z39.50

BiblioteQ supports both the SRU and Z39.50 Internet search queries for books, journals, and
magazines. Sites may be defined within the biblioteq.conf file.
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Special Data

Dates are recorded in MM/dd/yyyy format.
ISBNs are recorded without hyphens.
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Terminal Options
--help

Display terminal options.

--open-postgresql-database <name-of-database>

Connect to the specified PostgreSQL database. The connection is established via the guest account.
--open-sqlite-database <absolute-path-of-database-file>

Open the specified SQLite database file.

--open-sqlite-database-index <index>

Open the SQLite database at the specified index.

--prepare-csv-import-file <absolute-path-of-csv-file>

Populates the CSV File widget of the CSV Import Browser with the specified file name. The file should
exist.

--special-executable <absolute-path-of-executable>

The argument provided to special-executable will appear in Tools — External Applications. The
environment variable BIBLIOTEQ _DATABASE_NAME is available to the new process. Multiple
special-executable instances are allowed. Please note that BiblioteQ does not validate the paths of the
applications.

--special-executable-icon <absolute-path-of-icon>

Set the action icon of the application specified via --special-executable. Please note that BiblioteQ does
not validate the paths of the icons.

Example: BiblioteQ --special-executable /opt/dooble/Dooble —special-executable-icon
/opt/dooble/Dooble.png.
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Translations

Translations are incomplete. Translating BiblioteQ text is simple. Please download and install Qt from
https://download.qt.io, download BiblioteQ’s source, and familiarize yourself with Qt’s Linguist.
Linguist documentation is available at https://doc.qt.io/qt-5/gtlinguist-index.html.

Literal text, for example text housed in a combination-box widget, will be recorded to a database in its
translated form. In general, BiblioteQ does not translate database entries.
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Upgrading a PostgreSQL Database Schema

Some software releases require database schema changes. Please read the version-specific section of
the postgresql_update_schema.sql file and execute the required SQL statements.
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Upgrading an SQLite Database Schema

It may be necessary to upgrade an existing BiblioteQ SQLite database schema after a software release.

An upgrade tool is available via the Tools menu. A confirmation prompt is displayed before the process
is initiated. After the upgrade process is completed, a dialog depicting the results of the upgrade will be
displayed. Please create a backup of the SQLite database before upgrading it.

‘;“ -+ BiblioteQ: Upgrade SQLite Schema Results T ¢

kxecuting 2 statement(s).

1. CREATE TABLE book_conditions (condition TEXT NOT NULL
PRIMARY KEY)

Error 1: table book_conditions already exists unable to execute
statement. Statement: CREATE TABLE book_conditions (condition
TEXT NOT NULL PRIMARY KEY).

2. CREATE TABLE book_originality (originality TEXT NOT NULL
PRIMARY KEY)

Error 2: table book_originality already exists unable to execute
statement. Statement: CREATE TABLE book_originality (originality
TEXT NOT NULL PRIMARY KEY).

® Close

48 of 50



BiblioteQ

Index

B Y USRI 30 Database Enumerations................eeeeeeeeeeeeeeeen. 16, 25
Accessing an Existing SQLite Database.............. 11 Database Enumerations Browser.............. 16, 26, 40
AN« B £33 s VRS RR 6, 24 Database Search..........ccooevveevveeveeeeeeiierinananns 25
AAINNIIL. e e eeeeeeeeee e e ettt e e e e eeteeeeeeeeeeeeenaaeeeeeeeneannans 7 database Name........cceuueeeeeeeneeeeeeeeeeeeeeeeeeeeenenns 36 f.
administrator.......ccoeeeeveeennen. 6f., 16, 24 ff., 32, 40 f. database_tyPe......ccceevueerrreerrrieerieenieeeieeeire e 36
Administrator.........cccvveeecieeeiieeeee e 32 Delete Selected Item(S)....ccceevrreeercrreeeeesreeeeennnnn 24
Administrator BrOWSer............coovvevevrrvvnnnns 7, 25, 32 digital video diSCS......cccceerurercrernreriierieenen. 6, 39 f.
Administrator GUIide............coeevvvvveveeieeeieeeeeeeeeeeenenns 3 DISCONMMECE.cuueeeeeeeeeeeeeeeeeeeeee e eeeeeeeeeeeees 17,25
All Requested..........cceeeeereieenieenieenieenieenieenneens 39 Display Members Browser...........ccceecvvereveerveenne 25
All ReSEIVed.......evvveeeiieiiiiiiiiieiieeeeeeeee e 41 DUE DaAte......eeeeveeeeeeiiieeeieeeeeeee e 40
AIPha...ceiiiieeiieeeeeeee e 30 Duplicate Selected Item(s)......ccceeevveercuveerceveennnnen. 24
AMD o 30 EITOr LOG..ccuveeeeiieeiiteeeeeeeeteeeeee e 18
2N 3T | o) [« IO PSR 30 Exit BiblioteQ.....coooevvviiieeiiiieeieieeieeeeeeeeeenreeeeees 26
ARM..coiiiiiiiiieteetteet ettt 30 Export Table View as CSV....ccccccoveerviirieeniieennne. 19
ASIINS. oo 36 Filluuueieeeeieeeeeeieeeeeeeee e 4,11,13,17,19
DACK UL et e e e e e e eeeeaans 37 FileS BIrOWSEeT...ceuuueeeeeeeeeeeeeeeeeeeeeeeeeeeeeaeeeeeeeaaenees 25
biblioteq_patron..........cccceeveerrieerienrieenieeieeeenn 27 fOIMAL...cccuvieeiieeiieeieeeeeee et e e 38
biblioteq.conf..........cccceeeiieriiiiiieeeeeeeee 36, 43 FreeBSD........ciieoiiieieeeeeeeeteeeee et 30
BiblioteQ.CONF.......cooiiiiiieieieeeeeeeeeeeeeeeeeeeias 9 fTONE_UTLeeeeeeeeeeeeeeeeieeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeees 37
BiblioteQ.INT.......cooiiiiiirieeieeeeteeeeeee e 8 Grant Privileges.........ccoceerieinieniieniiienieeieeeee 27
Book Binding TYpes.......cccceeeveerieenieenieenieennnnn 16 grey literature..........ccceeeeveervveenveeesveennne 6, 20, 39 1.
DOOKS..cceeiiiteeeeeeeeeeeeeeee 6, 20, 29, 39, 43 GUESL...c..eeeruierieeiieeieeite ettt 25, 32
BOOKS. ..ottt 40 NOSt...cccoereeeeeeeeiieeeec et 36
Branch Name.........eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeenans ST B 1 V0 1] 11T 10 0 < 36
Branch Selection..........cccovvevevuvveeeeeeeeniiinns 4,25, 36 HTTP.coooooeeeeeeeee ettt eeeeeeteee e e e sesaaes 36f
(@F: 11=1=00) ) /20N SO U ORI PP 39 hyperlinks.......cccooveeriiiniiiniienieeeere e 21
Change Password..........cceeueeeeveeniiernieeenieescieennne 25 Ttem Creation.........cceeeeeeveeneenrieeneessveeneens 24, 32 1.
CIrculation.......ccoeveeeeieeeeeeeeieieeeeeeeeeeeeenenes 25, 27, 40 f. Ttem Deletion.........ccovvvvvveveiiiiieiiiiiiiiiiniennenn, 24, 32 f.
CArculation.......ccouveeeeeeeieeeeeeciieee et 32 Item Reservation Status.............eeevevevevevevennnnnnnnnnn 41
ClRAT.....ceieeeeeeeeeeeeeeeeeeeeeee et eeeeeeetere s 4 Ttem ReServations.......coeeeveveeeeeeeeeeeeeeeeeeeeeenns 25,32 f
COMPACt AiSCS...uvverrereeerieeiieerieenireeireesneenes 6, 39 f. Item RetUINS.....c.ceeevieeiieriieeiieeieeee e 32f.
Configure Administrator Privileges.................. 7, 25 Ttem Updates........ccceeveeveieniennieenieeieenieeieenne 24, 33
(@) 81 1 (<Y of PO 4, 11, 25 journalS.......ccceeeeveeeveercieeniieesieenreenns 6, 20, 39f., 43
CONNECtiON_OPLiONS......eeervieerreeeeiieeerreeeiereeeaeeenns 36 librarian.........eeeeeeeeeeeeeeieeeeeeeeeeieieenn 6, 16, 26
COPY BIOWSET....cooeiiiteieiiieeeeieeeeeeieeeeeeieeee e 40 Librarian........ccceeeeveerieeieeeiieenieeseeeseeeseeesseenneens 32
CIEALE....cceeeeeeeeeeee et e e e e e e ereraraee s B LIMIT....oomeeeeeeeeee e e e eeeeeees 23
CreatedD......coocveieciieeiecieeeeeee e 12 LANGUIST.eeeuveevieeieeieeeieeniteereesieeeieeseeesaeenenesneeens 46
createlang.........cooceeeiieiiiiiniiee 12 LANUX ittt ettt e 30
Creating an SQLite Database............cccceeeuveernnnenn. 3 Fo Ytz 1 N« Lo TR 5,11
CSV e 19, 22 MAC OS Xiooovviiiiieeeeieeeeieee et ceerr e e eesareeeeen 30
Custom Database QUETY.........ccceevveerveerveenveennnenn 25 MAGAZINES....ceevvrerrrerreenreeeveeeveeneens 6, 20, 39f., 43
Custom QUETY........eueeereiiieeriiiieeeeeireeeeeeeeeeeeeaeee 14 Member Creation.........cceceereerreeeniensieeneessveeneens 33

49 of 50



BiblioteQ

Member Deletion...........ccecveeriieenieennieennieeeneen. 33 Reservation Histories.........ccceecveeeirieieeeenineeeennns 33
Member Updates..........ccceeeveeerieeeneeenieeeniieesneennne 33 Reservation Status.........cceeceeevveerieeensieenieeenieeennees 41
Member’s Reservation History..........ccecueevruveennnee. 28 RESEIVE.....etiiieeiiieeeeeiiteeeeetteeeessiree e e saeeee e s 40
Members BIrOWSET........cuuueeeemieeeeeeeeeeeeeeeeeeererennnnns 40 Reserve Selected Item.........eeeeeeeeeeeeeeeevenennnne. 25, 40
membership......cocceeeveviiiiniiieiceee, 25, 27 Save Changes.........cccecveeeeriieeerniveeeniieeeesieeesssnneeens 7
Membership........ccocveeviiniieriiinieeeesee e 32 Select SQLite Database...........ccceeveereeercieensueennenns 5
Modify Selected Ttem(s)......ccccveeveerveerveerveennnenn 24 Select Viewable Columns..........ccccoeeveeiriieeninennnns 24
TIAITIC. c..envenreeureeareeareereseeeneesaeeemeesaeesmnensnesaeenae 37 £. SOCKSS...ceiiiieiieieeeetcteecece e 36f
New SQLite Database..........ccccceervureeiriveernsneennnne 13 SQLILE.ceeetieeeieeeetee et 36
INODIE....ceiieieeteee e e 36 f. SQLite.....ccoevvureeeannnnen. 3f, 6,11, 13, 23, 27, 30, 48
OFFSET ...ttt ettt 23 SRUL ittt 43
Open Library........ccoceeeeieeniieniieeieerieeesiee s 29 ssl_enabled.........ccoocveeriiiniiiiieie e 37
OpPENBSD......coiiiiieiieteecreecre e 30 Sun UHraSparc........cccveeeeecveeerneveeessineeessieeeeennns 30
OS /2.t 30 SYSTEML..euvirreriieniteieerieeieeteeiee st eeees 36f.
Pagination..........cceeerieeeniieeinieeenieeenree e 23 Telephone.........coocciiiiiiiieiriiieieieeeeeee e 39
PASSWOT...couviiiiieiieeiteeie et 10, 38 tiIMEOUL...ueueeeee e 38
PassSWOId.........coooovviiiiiiiiiiiiiiiieeee 11 TOOIS.ccciiiiiiiieieeeeeeeeeee e 22,48
Password Selection........ccevvvveeveeeieieieieeeeeeeens 10, 25 TranslationsS........eeeeeeeeeeeeeeeeeeeeeeeeeeeereeeeeeeeeeeeeees 46
PaAth.cciiiiiiiieececee e 36 UNACCENT()eervvreerrerreerireernireeenireeesreeesseeeesssneeennns 35
PATOM. .ttt ettt ettt saresreesaeeas 24, 32 UPGTade......ceveiiiiiieeieeieeeieerte et 48
PALTOMIS. ¢ uivreeeireeeereeeenireeesareeessreesssreesnseneesnsnes 39 UTL SO 37
PDF ...ttt 31 UL ISSI ittt 37
photograph collections...........ccceevvveeiinvieeeinnineenn. 6 USETid....ceeiieiieeieiiieeeiieeerree e 11
PIPESAL. i 12 USETNAME. ....ccuvierureeiierieeiteeteesieeeteesteesreesseeseeens 38
207 0] ] (<) FS TSR 31 video Zames.........cccveeeeerieenieeiienieeie e 6,39 f
POT ettt ettt sttt et re et saee e s 36, 38 VIEW...oiiiiiirieieeieneceerceteeeee e 18, 27, 41
POSEEIESL.eeeiueieieiieeeiieeeieeere et see e 36 View Member’s Reservation History (Patrons
PostgreSQL................ 3,61, 111,23,27,32, 39 ff. ONlY)..eeiiiiiiiiiiiiiieee e 24
postgresql_create_schema.sql............cccuuuueeee. 12, 32 View Selected Item(S).....cccvvrreerrrureeerrriveeeresinnenenn 24
postgresql_update_schema.sql...........cccceeuueenneen. A7 WINAOWS....uviiiiieiieiieeiteniteeie et et siee et e saesaees 30
POWEIPC ...ttt e e eeevees 30 Xbook_admlinN.....ueeeeeeeeieeeeeeeeieeeeeeeeteeeeeees 12,32
Print Current VIeW.......c.coovveeviiinienieeniieeieenieeeen 24 XDOOK_db....eouiiiiiiiiiiiiieiecceeeee 12
PrOXY_hOSt....cooiieiieiieeieeeeeeeceeee e B0 Ef. YAZ oottt 3, 30
PrOXY_PaSSWOTId......ccevveerruierniiennieenrieeeneeeennes 36 . YAZ_eeieieeeee e 38
0240047 010) y USRS 36 ff. Z39.50.....ccuuieieeeieeiieeeee et 43
PIOXY_LYPCuueeieniieeieeeieesieeniteseeesatesreesneeeaeenae 36 f. Administrator Privileges...........ccecceervueinieniieniuenne 7
PIOXY_USEIMAIMIC. ..cccuvvreerurreeenrreeessnreesssereeennnes 36 f. [Amazon Back Cover Images].........c.ccceeeruveeennnen. 36
@ R 30, 46 [Amazon Front Cover Images].......cc.ccccecueerveennee. 36
QELTS oo S [BranChe-d]uee ettt eveaaaes 36
Recent SQLite Files........ccccevvuiiniiniieiniinienieeiene 4 [Open Library Cover Images]..........ccccevvuveerunenn. 37
TECOTA_SYNLAX..uuveeerevreeerireeeenrreeesiereeensreeesssneeens 38 [Open Library]......ccccccevviieniieiieeeieeceeeseeee 37
Refresh Table.... ..o 25 [SRUL ittt eee e e e s e e eeeeeeeeeeees 37
Request Selected Item(s) / Cancel Selected [Z39.50-1]uucciieieieeeieeeiteeeiee e e e see e 37
ReqUESL(S).cccuvveeeereeiiieiniieeeieeeeee et 24

50 of 50



	Introduction
	Accessing an Existing SQLite Database
	Adding An Item
	Administrator Browser
	BiblioteQ.INI
	BiblioteQ.conf
	Change Password
	Connecting to a PostgreSQL Database
	Creating a PostgreSQL Database
	Creating an SQLite Database
	Custom Query
	Database Content
	Database Enumerations Browser
	Disconnecting from a Database
	Error Log
	Exporting a Table View to a CSV File
	File Attachments
	Hyperlinks
	Importing
	Limitations
	Main Window Tool Buttons
	Members Browser
	Member’s Reservation History
	Open Library
	Operating Systems
	PDF
	PostgreSQL Accounts
	PostgreSQL Benefits
	PostgreSQL unaccent()
	Preparing biblioteq.conf
	Requesting an Item
	Reserving an Item
	Returning an Item
	SQL Injections
	SRU & Z39.50
	Special Data
	Terminal Options
	Translations
	Upgrading a PostgreSQL Database Schema
	Upgrading an SQLite Database Schema

